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1 KÄYTTÖLIITTYMÄ 
 
Työkalupaletti  Options-palkki    Kelluvat paletit 

 
 

 
 
Kuvankäsittelyssä tarvittavat työkalut, kuten piirto- maalaus- teksti- ym. työkalut löytyvät 
työkalupaletista. 
 
Suurimmalla osalla työkalupaletin työkaluista on säädettäviä lisäominaisuuksia, joita voidaan ohjata 
Options-palkista. Palkissa näkyvä sisältö muuttuu sen mukaan, mikä työkalu kulloinkin on 
valittuna. Osa Options-palkissa olevista kohteista on avattavia paletteja. Napsauttamalla kolmiota 
paletti aukeaa näytölle.  
 

  
 

  
 
Napsauttamalla itse työkalun kuvaa Options-palkin vasemmassa reunassa voit palauttaa työkalun 
asetukset valitsemalla Reset Tool. 
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2. TYÖKALUPALETTI 
 
Mover (Siirto) 
 
Zoom (Suurennuslasi) 

 
Hand (Käsi) 
 
Eyedropper (Pipetti 
 
Marquee (Aluevalinta) 
 
Lasso (Lasso) 
 
Magic Wand (Taikasauva) 
 
Quick Selektion (Pika valinta) 
 
Type (teksti) 

 
Crop (Rajaus) 
 
Cookie Cutter 
 
Straighten (Suoristus) 
 
Red Eye Brush (Punasilmäisyys) 

Spot Healing Brush (Korjaussivellin) 
 
Clone Stamp (leimasin) 
 
Eraser  (Pyyhekumi) 
 
Pencil (Kynä) 

 
Paint Bucket (Maalipurkki 
 
Gradient (Liukuväri) 

Rectange (Suorakulmio) 
 
Blur (Sumennus) 
 
Dodge (Varjostus) 

 
Switch foreground and background colors (Piirtovärin-ja taustavärin 
vaihto) 
Piirtoväri 
Oletusvärit /Taustaväri 
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Marquee (Aluevalinta) 
 

 

A) Suorakaide   B) Ellipsi      C) Uusi valinta   D) Lisää   E) Vähennä   F) Leikkaa 

 
Lasso 
 

 
 

 
A) Lasso   B) Polygonaalinen lasso C) Magneettinen lasso    

D) Uusi valinta   E) Lisää   F) Vähennä   G) Leikkaa 

 

Quick Selektion 

 

 

A) Pika valinta    B) Valinta pensseli      C) Uusi valinta   D) Lisää   E) Vähennä    
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Selection Brush (Valintasivellin) 
 

 
 
A) Lisää   B) Vähennä  C) Sivellin paletti D) Siveltimen koko E) valinnan näyttötapa Maski/Valinta 
F) Siveltimen kovuus 1 - 100 % 
 

 
 
 
 
 

Sumennus 
Terävöitys 
Hankaus 

 
 
 

 
Sieni lisää värikylläisyyttä 
Vaalentaa 
Tummentaa 
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3. PALETIT 

Photoshop Elementsissä on runsaasti kelluvia paletteja, jotka sisältävät mm. väriluetteloita, 
efektejä, suotimia, tyyliluetteloita jne. Ne saadaan näkyviin valitsemalla haluttu paletti Window-
valikosta ja pois näkyvistä napsauttamalla niiden oikeassa yläreunassa olevaa sulkemispainiketta. 
Paletit voi vetää näytölle haluamaansa paikkaan ja niitä voi myös yhdistää vetämällä niitä muiden 
palettien päälle. 
 
3.1 Navigator 

 
Navigator-paletin avulla voit suurentaa ja pienentää 
kuvaa. Kuva näkyy pienoiskoossa paletissa. Kuvan kokoa 
voi säätää liukusäätimestä 

 
 
3.2 Undo History 
 

 
 
History-paletissa voi kumota edellisiä toimintoja. Valitse toiminto, jonka haluat kumota. Paina 
hiiren oikeanpuoleista painiketta ja valitse Delete.  
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3.3 Leyers (Tasot) 
 
  
Sekoitustilat                  Peittävyys 

Uusi taso                                  
Aktiivinen taso  

Säätötasovalikoima       
Näkyvä taso  

    
   
    

                                                                                                                            
 
 
Ennen terävöitystä ja tallentamista muihin kuin Photoshop- tai TIFF-muotoon kuvan tasot täytyy 
yhdistää. Tasojen yhdistämisen jälkeen kuvaa ei voi enää muokata. Tasot yhdistetään valitsemalla 
Layer, Flatten Image (Taso, Yhdistä tasot). 

 
Sekoitustilat 

Normal, normaali. Kun Opacity on 100 %, jokainen aktiivisen tason pikseli näkyy tässä tilassa 
riippumatta allaolevista väreistä. 
 
Dissolve, roiskiva: vaikuttaa häivytettyihin ja pehmennettyihin reunoihin eli asettaa pikselit 
satunnaisesti kuvan reunoilla. Opacity 50 %.  
 
Multiply, kertova: antaa vaikutelman kuin katsottaisiin kuvaa kahden diakuvan läpi valoa vasten ja 
tuloksena on aina tummempi kuva. 
 
Screen, rasteri: vaikutelma että kuvaa heijastetaan valkokankaalle, tulos vaaleampi. 
 
Overlay, sulauttava: sekoittaa värit kuvan väreihin. Ei sekoita täysin mustia ja valkoisia kohtia. 
   
Soft Light, pehmeä valo: kuvan väreistä riippuen tummentaa tai vaalentaa kuvaa.  
 
Hard Light, kova valo: vaikutus voimakkaampi kuin Soft Light-tilassa. 
 
Color Dodge, värivarjostus: jokainen väri lisää kirkkausarvoa. Vaaleat värit aiheuttavt suurimman 
muutoksen. PhotoShopissa paras tapa valkaista kuva 
 
Color Burn, värilisävalotus: tummentaa kuvaa 
 
Darken, tummentava: vaikuttaa aktiivisen tason väreihin vain jos ne ovat tummempia kuin 
vastaavat alla olevat pikselit. 
 
Difference, erottava: muuttaa alemmat tasot käänteiseksi aktiivisen tason kirkkausarvojen 
mukaisesti. 
 
Exclusion, poistava: muuttaa keskiväriset pikselit harmaiksi, mikä luo matakontrastisen tehosteen. 
 



KAMERASEURA 74 PHOTOSHOP TYÖPAJA 17.04.2010/JK 
 

7 

Hue, sävy: aktiivisen tason sävyarvot säilyvät ja sekoittuvat alla olevan kuvan kyllläisyysarvoihin 
ja värin kirkkausarvoihin. 
 
Saturation, kylläisyys:maalattava väri korostaa tautan värejä. Aiheuttaa useimmiten vain vähäisi 
muutoksia. 
 
Color, väri: yhdistää sävyn ja kylläisyyden 
 
Luminosity, värin kirkkaus: aktiivisen tason valoisuusarvot säilyvät ja sekoittuvat alla olevan 
kuvan sävy- ja kylläisyysarvoihin. 
 
4 DOKUMENTISSA LIIKKUMINEN 

4.1 Zoomaus  
 

 
 
Valitse työkalupaletista Zoom Tool (suurennuslasi) ja napsauta kohdassa, jota haluat suurentaa. 
Voit myös vetää hiirellä alueen suurennuslasin kanssa, näin saat juuri haluamasi alueen 
suurennettua. 
 
Zoomaa kuvaa pienemmäksi pitämällä Alt-näppäintä pohjassa ja napsauttamalla samalla 
suurennuslasilla kuvan päällä. 
 
Voit käyttää myös Options-paletin    +  ja -  –painikkeita.  Tiettyyn prosenttikokoon voit Zoomata 
antamalla arvon suoraan painikkeiden vieressä olevaan ruutuun. Liukusäätimellä voit säätää myös 
zoomausta. Tarkan prosentin saat säädettyä klikkaamalla liukusäädintä  lisäämällä tai vähentämällä 
nuolinäppäimillä  ↑ ja ↓ . 
 
Fit Screen sovittaa kuvan näyttöön Print Sitze näyttää kuvan tulostuskoossa 
 
Hiiren oikealla painikkeella saat näkyviin valikon: 
 

 

4.2 Vierittäminen käsityökalulla   
 
Jos kuva on suurempi kuin mitä näytölle yhdellä kertaa mahtuu, sitä on vieritettävä päästäkseen 
juuri haluttua aluetta. Vierittämiseen voidaan käyttää vierityspalkki-käsityökalua. 
 
Zoomauksen ja vierittämisen voi suorittaa myös Navigator-paletista, jonka saat näkyville käskyllä 
Window/Navigator. Paletissa näkyy pikkukuva avoinna olevasta dokumentista ja punainen 
suorakaide sen päällä. Suorakaiteen paikka vastaa kuvaikkunassa näkyvää kuvan osaa. Kun 
suorakaidetta siirretään, muuttuu ikkunan näkymä sen mukaisesti. 
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5 ALKUTOIMET 

5.1 Kuvan rajaaminen  
 
Valitse rajaustyökalulla vetämällä alue, jos rajaus ei heti osu kohdalleen, voit säätää sitä 
siirtämällä rajaus haluamaasi kohtaan tai suurentaa/pienentää kahvoista joko sivuilta tai kulmista. 

Rajausta voi kiertää kulmien ulkopuolelta  Hyväksy rajaus tai  paina Enter-näppäintä tai 
kaksoisnapsauta hiirellä rajauksen sisäpuolella, näin kuvasta leikkautuu ylimääräinen osa pois. 
 
5.2 Kuvan kääntäminen 
 

 
 
lmage-valikon Rotate-valinnalla saat käännettyä kuvan oikeaan asentoon. 
 

5.3 Kuvan koon tarkistaminen Alt+Ctrl+I 
 
Valitse Image/Resize/Image Size ja varmista, että kohta Resample Image ei ole valittuna. Syötä 
Resolution-kohtaan käyttötarkoitukseesi sopiva resoluutio. (ks. Resoluutioita). Document Size 
kohta kertoo, mikä on suurin koko, jossa kuvaa voidaan käyttää ilman laadun kärsimistä. 
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5.4 Kuvan koon muuttaminen 
 
Digitaalisia kuvia on mahdollista pienentää käytännössä rajatta ilman että kuvan laatu laskee. 
Kuvan suurentaminen ilman laadun heikkenemistä ei kuitenkaan onnistu. 
 
Photoshop Elements osaa tarvittaessa lisätä tai vähentää kuvan pikseleiden lukumäärää, ja näin 
kuvatiedoston kokokin muuttuu. 
 
Kuvan pienentäminen Photoshop Elementsissä vähentää kuvan pikselien lukumäärää. Halutessasi 
pienentää kuvaa, laita rasti Resample Image -kohtaan, syötä kuvalle haluamasi leveys tai 
korkeus. Voit antaa vain toisen näistä arvoista, toisen ohjelma laskee automaattisesti. 
Kun poistat valintamerkin kohdasta Coutstrain Proportions (säilytä mittasuhteet), niin voit 
muuttaa pelkästään kuvan leveyttä tai korkeutta. Pieniä muutoksia kuvan mittasuhteissa on hyvin 
vaikea havaita, ja toimintoa voi esim. käyttää, jotta kuva täyttäisi juuri sille tarkoitetun tilan. 
 
Koska kuvan suurentaminen edellyttää, että kuvaan tulee lisää pikseleitä, joutuu ohjelma 
tekemään niitä lisää. Koska Photoshop Elements ei voi mistään "tietää", mitä yksityiskohtia 
kuvassa tulisi näkyviin sitä suurennettaessa, se joutuu rakentamaan uudet pikselit olemassa 
olevien pikselien perusteella. Tällainen uusien pikselien arvaaminen onnistuu vaihtelevalla 
menestyksellä. Suurentaminen kannattaa tehdä vaiheittain esim 10 %:n välein. 
 

Resample Image/interpolointitapa 
 
Nearest Neighbor (Lähin naapuri ) Nopea 
mutta vähemmän tarkka menetelmä, joka kopioi 
kuvan pikselit. 
 
Bilinear: Menetelmä, joka lisää pikseleitä 
ottamalla ympäröivien pikselien väriarvoista 
keskiarvon. 
 
Bicubic: sumentaa reunoja . Sopii valokuvien 
tms. suurentamiseen (tai pienentämiseen) 
 
Bicubic Smoother (Tasaisempi) 
Tämä on hyvä menetelmä suurennettaessa kuvia. 
 
Bicubic Sharper (Terävämpi)  
Hyvä Bicubic-interpolaatioon perustuva 
parannettua terävöitystä käyttävä menetelmä 
kuvan koon pienentämiseen. 
  

 
 
• Scale Styles, joka tarkoittaa kuvassa käytettyjen tyylien skaalautumista uusien arvojen 
mukaisesti, esimerkiksi tekstissä käytetyt tasotyylit. 
• Constrain Proportions (säilytä mittasuhteet) tarkoittaa, että korkeus ja leveys on linkitetty 
toisiinsa eli muuttamalla jompaakumpaa arvoa myös toinen muuttuu. 
• Resample image vaikuttaa kuvan laatuun pienettäessä kuvaa ohjelma joutuu poistamaan 
pikseleitä ja suurennettaessa lisäämään eli keksimään uusia pikseleitä. 
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5.5 Kuvakoon muuttaminen rajaustyökalulla 
 
   
Rajaustyökalun  
asetukset (leveys 27 cm, 
korkeus 19,2 cm Resoluutio 
300pix) 
 
 
 
 
 
 
 
 
Rajaustyökalu 
 
 
Hyväksy rajaus painamalla Enter tai kaksois klikkaamalla rajauksen sisällä tai kuvan  alta    

 ���� hyväksy  ���� peru 
  
Nyt kuva pieneni 27x19,2 cm mittoihin (Peterson kalenterikuva) 
 

5.6 Piirtoalueen koon muuttaminen Image/Resize/Canvas Size... 
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Lisää kuvaan 5 cm:n harmaan kehyksen, kun Relative valinnassa on ruksi 

Piirtoväri 
Foreground  

 
Taustaväri 
Background 

  
 

5.7 Kuvagalleriaan ja kuvakisaan kuvan pienentäminen 
Image/Resize/Image Size Alt+Ctrl+I 
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Muutetaan alkuperäinen kuvan leveys 4288 � 1024 (vaakakuva).  
 
File/Sve AS 
 

 
 
Uusi tiedostonimi (ettei alkuperäinen tuhoudu) ja sitten Tallenna 
 

 
 
 Sitten OK 
 
5.8 Perspektiivin korjaus 
 
Valitaan koko kuva alue Ctrl A 
 

     
 
     Valitaan View/Grid 
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Valitaan Image/Transform/Perspektive 
 

 
 
Vedetään kuvaa kulmista kunnes pystyviivat ovat suorassa 
 
Kaksois klikataan kuvaa ja poistetaan ruudukko Viev/Grid ja koko kuva-alueen valinta Ctrl D ja 
rajataan tarvittaessa kuvaa. 
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5.8.1 Correct camera distortion 

Filter > Correct Camera Distortion 
 

 
 

 
 
 
Pystylinjoja voi korjata Vertical Perspective-säätimellä
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5.9 Resoluutioita  
 
Tulostusväline  Kuvan resoluutio (dpi) 
Kuva nettiiin/näytölle  72 - 75 
Mustavalko lasertulostus  100 - 150 
Sanomalehti   150 - 180 
Värilaser   150 - 180 
Mustesuihku   180 - 300 
Kuvavalmistamo 240 - 300 
Neliväripainatus  300 tai enemmän 
Omalla tulostimella kannattaa kokeilla alhaisempiakin resoluutioita kuin yllä oleva lista 
suosittaa. Parhaan vertailupohjan saa, kun tulostaa saman kuvan eri resoluutioilla. Huomaa 
myös, että kuvan suurentaminen ja pienentäminen muuttavat resoluutiota. Jos esim. 
skannatun kuvan resoluutio on 200 dpi ja suurennat sitä 200 %, on kuvan resoluutio sen 
jälkeen 100 dpi. Pienennettäessä tapahtuu luonnollisesti päinvastainen ilmiö. 
 

5.10 Roskien poisto  
 
Kuvassa olevat roskat voi poistaa kloonaavan leimasimen (Clone Stamp tool) avulla. Suurenna 
kuva vähintään 100 %:iin. Valitse työkalupaletista kloonaava leimasin (Clone Stamp Tool). 
Napsauta Options-palkin siveltimen kokomäärityskohtaa ja määritä sopiva siveltimen leveys. Koko 
kannattaa valita hieman pienemmäksi kuin poistettava alue. Siirry korjaussiveltimellä alueelle, joka 
on väriltään ja tummuudeltaan mahdollisimman samantyyppinen kuin mitä korjattavasta kohdasta 
on tarkoitus tulla. Paina Alt näppäin pohjaan, napsauta hiirellä ja vapauta Alt-näppäin. Siirry 
tarkasti roskan päälle ja paina hiiren ykköspainike alas. Maalaa roska pois pienellä kiertoliikkeellä. 
 
 
6. SISÄLLÖN MUOKKAUS 
 
6.1 Aluevalinnat 
 
Aluevalinta on kuvan yksittäisten osien muokkausten perusta. Se suojaa ulkopuolelle jäävän alueen 
- kaikki muokkaus- ja säätötoimenpiteen kohdistuvat valitun alueen sisäpuolelle. 
Valintatyökaluja käyttäessäsi Options-palkin valinnan säätelypainikkeilla saat määriteltyä 
esimerkiksi sen, että uusi valinta lisätään jo aikaisemmin valittuun alueeseen. 
 
Suorakulmaisen (Rectangular Marquee Tool) ja elliptisen (Elliptical Marquee Tool) valinnan 
saat valitsemalla työkalupaletista kyseiset työkalut. 
 
Tarkalleen neliön tai ympyrän muotoisen alueen saat valittua painamalla Vaihto -näppäimen 
pohjaan valintaa tehdessäsi. 
 
Valinnan saat kumottua napsauttamalla kuvaa valintatyökalulla jonnekin 
alkuperäisen valinnan ulkopuolelle. Voit myös poistaa valinnan 
valitsemalla Select -valikosta käskyn Deselect. Käänteisen valinnan saat 
tehtyä valitsemalla Select- valikosta Inverse. 
 
Tavallisen lasson avulla saat valittua erilaisia epäsäännöllisen muotoisia kohteita. 
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Reunoiltaan suoria kohteita on helpointa valita monikulmiolassolla. Etene napsauttamalla 
monikulmiolasson kärjellä kohteen nurkkakohdissa. Vie monikulmiolasso lopuksi aloituspisteeseen. 
Osoittimen alareunassa näkyy nyt pieni ympyrä. Napsauta hiirellä, niin lopputuloksena syntyy 
yhtenäinen valittu alue. 
 
Taikasauva on näppärä työkalu sellaisten kohteiden valitsemiseen, jotka ovat väriltään 

suunnilleen samanlaisia. 

 

6.2 Valinnan reunan muuntelu 
Normaalisti valintyökaluilla aikaan saatavat reunat ovat terävät. Joskus lopputuloksesta tulee 
luonnollisemman näköinen, jos valinnan reunaa pehmennetään tai häivytetään sopivasti. 
Häivytyksen saat tehtyä käskyllä Select/Feather (häivytys) Alt+Ctrl+D. 

 
7. TEKSTIN KÄYTTÖ 
 
Photoshop Elemntsiä ei ole tarkoitettu tekstinkäsittelyohjelmaksi, mutta muutaman tekstirivin 
kirjoittaminen sillä onnistuu. Kun haluat kirjoittaa tekstiä, valitse työkalupaletista Horizontal Type 
-työkalu, napsauta kuvaa kohdassa, johon haluat kirjoittaa tekstiä ja kirjoita haluamasi teksti. 
Valitse teksti aktiiviseksi hiirellä maalaamalla ja valitse haluamasi koko ja tekstityyli ja väri 

Options-palkista. Hyväksy muutokset options-palkin  Commit painikkeella. 
 

 
 

8. VÄRIKORJAILUT 

 
Säätö- eli värikorjailutasojen avulla värikorjailuun saadaan rajaton perumismahdollisuus. Koska 
värikorjailutasot eivät tee kuvaan pysyviä muutoksia ennen tasojen yhdistämistä, voidaan 
säätötasoilla oleviin korjauksiin puuttua missä vaiheessa tahansa. Alkuperäinen kuvadata säilyy 
aina muuttumattomana. Myös säätötasojen oletusarvoja kannattaa hieman muuttaa. 
 
Lisää kuvaan säätötaso valitsemalla Layers, New Adjustment Layer, Levels ja napsauta OK. 
 

 
Levels-valintaikkunasta (Tasot) voi säätää kuvan värisävyjä. 
 
Tasot-ikkunan histogrammi kertoo kuvassa esiintyvien 
sävyjen jakauman. Histogrammikäyrän vasemmassa reunassa 
ovat kuvan vaaleat sävyt ja oikeassa reunassa tummat sävyt. 
Ihanteellisen, oikein säädetyn kuvan histrogrammi ulottuu 
valitun tummuusasteen laidasta laitaan. 
 
Hyväksy OK. 
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8.1 Vaalean ja tumman pään asettaminen 

 
Seuraavaksi määritetään kuvan vaalein ja tummin kohta eli vaalea ja tumma pää. 

 
 
Avaa Tasot-ikkuna napsauttamalla histogrammin kuvaketta  Tasot-paletissa.  

 
Napsauta Tasot-ikkunassa valituksi Preview (Esikatselu). 
Napsauta hiirellä oikeanpuoleista, vaaleakärkistä pipettiä, niin 
että pipettipainike jää pohjaan. 
Siirrä pipettiosoitin kuvaan ja napsauta sellaisessa kohdassa, 
jonka haluat olevan lähes valkoinen, mutta johon tulee kuitenkin 
vähän sävyjä. Histogrammi siirtyy kohti asteikon oikeaa (vaaleaa) 
reunaa.  
 
 
 
 
 
Seuraavaksi määritetään kuvan tummin kohta, jota ei haluta aivan 
umpimustaksi: valitse vasemman puoleinen tummakärkinen 
pipetti. 
Napsauta pipetillä eri puolille kuvan tummimpia kohtia. 
Histogrammi leviää tasaisemmin myös vasempaan reunaan ja 
kuvaan tulee lisää sävyvaihtelua tummiin sävyihin ja kontrasti eli 
tummien ja vaaleiden sävyjen ero kasvaa entisestään. 
 
 

 

Tarkasti voit säätää vaalean/tumman pään painama Alt-näppäin alas ja samalla liikuttamalla vasenta 
tai oikeata kolmiota kunnes ensimmäiset tummat tai vaaleat osat kuvassa alkavat näkyä. 

 

8.2 Harmaatasapaino  
 

Kuvassa saattaa olla esim. skannauksessa syntyneitä tai vaikeiden valotusolosuhteiden aiheuttamia 
värivirheitä. Ne voidaan poistaa säätämällä kuvan harmaatasapainoa. 
Valitse keskimmäinen pipetti 
Napsauttele pipetillä kuvan harmaita kohteita.  
Histogrammi muuttuu hieman joka kerta ja kuvan värit muuttuvat luonnollisemmiksi. 
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8.3 Tummuus  
 

Viimeinen Tasot-ikkunassa tehtävä kuvan säätötoimenpide on kuvan tummuus, joka määritetään 
histogrammin alapuolella olevalla liukusäätimellä. 
 
Vedä liukusäädintä oikealle, jolloin kuva tummenee. Vasemmalle vetämällä kuva vaalenee. 
Tummuutta voi säätää myös syöttämällä numeroarvo histogrammin yläpuolella olevaan 
keskimmäiseen ruutuun. 
 

 
 
Tummuutta täytyy vähentää usein digikuvissa, jotka tulostuvat helposti liian tummina. 
Tavallisimmat arvot ovat 1,1 - 1,5. 
 

8.4 Värikylläisyys 

 
Jos kuva näyttää ”hailakalta” siihen voidaan lisätä värikylläisyyttä. 
Lisää uusi säätötaso Layers, New Adjustment Layer, Hue/Saturation (Tasot, Uusi säätötaso, 

Sävy ja kylläisyys) 
 

 
 
Vedä Saturation (Kylläisyys) –liukusäädintä oikealle, 
jolloin kuvan kaikki värit muuttuvat kirkaammiksi ja 
puhtaammiksi. Liika värikylläisyys tekee kuvasta 
luonnottoman. Useimmin toimivat arvo 10-20 väliltä. 
Hyväksy muutos OK:lla. 
 
Liukusäädintä voi liikuttaa myös rullahiirellä tai 
nuolinäppäimillä  ↑ ja ↓  
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8.5 Värikorjailujen tarkistaminen 

 
Kun kuvan värikorjailut tehdään säätötasoja käyttämällä, alkuperäinen kuva ei muutu millään 
tavalla. Tämä mahdollistaa korjailujen poistamisen ja uudelleen säätämisen ilman, että alkuperäinen 
kuvan tieto muuttuu. 
Tasot paletin vasemmassa reunassa olevilla silmänkuvilla voi tason piilottaa, jolloin näkee kuvan 
ennen ja jälkeen korjausta. 
 

 
 
Ennen terävöitystä ja tallentamista muihin kuin 
Photoshop- tai TIFF-muotoon kuvan tasot täytyy yhdistää. 
Tasojen yhdistämisen jälkeen kuvaa ei voi enää muokata. 
Tasot yhdistetään valitsemalla Layer, Flatten Image 
(Taso, Yhdistä tasot). 

 

 

 

8.6 Kirkkaus ja kontrasti Brightnes/Contrast 

 
 
Tehdään samalla lailla säätötasolle. 
 
Kontrastiin ja sävyjakaumaan voi vaikuttaa Unsharp Mask (epäterävä maski) maskin avulla arvoilla 
Amout 20 %, Radius 50 pixels ja Treshold 0 
 
Vaaleita alueita voi varjella valitsemalle ne ensin Lasso-työkalulla summittaisesti ja Select Feather-
arvoksi 2-25 pix. (Alt+Ctrl+D). Sitten vaihdat valinnan käänteiseksi Select Inverse (Sift+Ctrl+I) 
komennolla. 
 
Valinnan saa pois painmalla Ctrl+D 
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9. TERÄVÖITYS 

9.1 Unsharp Mask (epäterävä maski) 

Terävöityksen oikea määrä riippuu tulostustavasta. Ruudulle tarkoitettua kuvaa pitää terävöittää 
vähemmän ja printille tarkoitettua enemmän. Liika terävöitys näkyy kuvassa ääriviivojen viereen 
syntyneinä vaaleina ”haloina”.  Enhance→Unsharp Mask 

          

Amount (Määrä) kuvaa terävöinnin "tehokkuutta". Pienissä, esim. webbikuvissa riittää 50–100%, 
suuremmissa printeissä pari sataa prosenttia tai enemmän. Vaikutusta kannattaa katsoa lopullisesta 
kuvasta. Katso vaikutus kuitenkin joko 100 % -koolla tai sitten jollain tasapienennöksellä: 50% tai 
25%. Kuvankäsittelyohjelman pienennys yleensä sotkee terävöintiefektin, jos pienennys on 
esimerkiksi 66 %. 

Radius (Säde) kuvaa, kuinka leveä terävöintivyöhyke reunoille tehdään. Kannattaa isontaa radiusta 
asteittain, kunnes juuri ja juuri erotat reunan terävöityksen lopullisessa kuvassa. Hyviä arvoja esim. 
nettiikuvissa 0.4–0.6, kymppikuville 1 ja isommille printeille 1.5. Sitä suurempaa ei yleensä tarvita 
kuvien parantamiseen, muut tehokeinot ovat asia erikseen. 

Treshold  (Kynnys) kuvaa vierekkäisten pikselien sävyeroa, mikä tulkitaan kuvion "reunaksi" ja 
mihin siis sovelletaan terävöintiä. Jos kuvassa on pientä tasaista kuviota tai esim. kohinaa, kynnystä 
suurentamalla vältytään terävöittämästä jokaista kuvio- tai kohinapistettä. Kannattaa seurata jonkin 
todellisen reunan terävöitymistä ja samalla koko kuvan "rakeisuutta". Sopiva lähtöarvo voisi olla 2. 
Jos kuva muuttuu liian rakeiseksi, suurenna kynnystä tai tarvittaessa pienennä määrää. Kynnyksen 
oletusarvo (0) terävöittää kuvan kaikkia pikseleitä. 

Klikkaamalla hiirellä Unsharp Mask-paletin kuvaa näet säädön vaikutuksen   tulee kuvan 
päälle. 
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9.2 Adjust Sharpenes (älykäs terävöinti) (Smart Sharpen CS 3) 

Älykäs terävöinti -suodin tarjoaa terävöityssäätöjä, joita Epäterävä maski -suotimessa ei ole. Voit 
asettaa terävöitysalgoritmin tai säätää tummien ja vaaleiden alueiden terävöityksen määrän. 

Enhance→Adjust Sharpness 

  
 

Amount (Määrä) asettaa terävöityksen määrän. Suuri arvo lisää reunapikseleiden välistä 
kontrastia, mikä tuottaa vaikutelman terävöitymisestä. 
 
Radius (Säde) määrittää niiden reunapikseleitä ympäröivien pikselien määrän, joihin 
terävöitys vaikuttaa. Mitä suurempi on säde, sitä suuremmat ovat ääriviivatehosteet ja sitä 
selvempää on terävöitys. 
 
Remove (Poista) asettaa kuvan terävöityksessä käytettävän terävöitysalgoritmin.  

• Gaussian Blur (Epäterävä maski) käyttää Gauss-sumennus-menetelmää.  
• Lens Blur (Linssisumennus) tunnistaa kuvan ääriviivat ja yksityiskohdat. Se 

tuottaa yksityiskohtien hienovaraisen terävöityksen, ja terävöityksen 
ääriviivojen ympärille aiheuttama kehä jää vähäiseksi.  

• Motion Blur (Liike-epäterävyys) pyrkii vähentämään kameran tai 
kuvauskohteen liikkeen aiheuttamaa sumeutta. Aseta Kulma-säädön arvo, jos 
valitset Liike-epäterävyys-suotimen. 

 
Angle (Kulma) asettaa Poista-säädön Liike-epäterävyys-toiminnon liikkeen suunnan. 
 
More Refined (Tarkempi) tämä toiminto poistaa sumeuden tavallista tarkemmin, ja siksi 
sen suorittaminen vie aikaa. 
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9.3 Enbos-terävöitys 
 
Avaa kuva ja monista siitä taso Layer→Dublicate Layer ja hyväksy OK. 
 

       
 
Layers-balettiin ilmestyy uusi taso Backgraund copy 
 

 
 
Valitse Filter→Stylize→Emboss  
 

      
 
Aseta Angle jäljittelemään kuvassa olevaa valon suuntaa. Pidä Heigth 2-3 pixels ja Amount lähellä 
100 % ja hyväksy OK. Vaihda monistetun tason tilaksi Overlay, niin ääriviivat on näin korostettu. 
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9.4 Kaksivaiheinen terävöitys 
 
I-vaiheessa valitse Enhance→ Unsharp Mask.  Amount 30…50 %, Radius 0,8…2 pixels ja 
Treshold 0 levels. 

              
 
 

II-vaiheessa tee samat Enhance →Unsharp Mask.  Amount 20…60 %, Radius 10…60 pixels ja 
Treshold 0 levels. 
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10. TALLENNUS 
 
Älä tallenna alkuperäisen kuvan päälle, vaan käytä komentoa File�Save As 
 

 
 

  
Photoshopissa on useita tallennusmuotoja 
 
 

 
 
JPG valinnat
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PIKANÄPPÄIMET 
 

Ctrl + A Valitsee kaiken 

Ctrl + B Väritasapaino 

Ctrl + C Kopioi 

Shift + Ctrl + C Kopioi kaiken näkyvillä olevan 

Ctrl + D Poistaa valinnat 

Shift + Ctrl + D Valitsee uudelleen 

Ctrl + E Yhdistää valitun tason alemman kanssa 

Ctrl + F Tekee viimeksi tehdyn efektin uudelleen 

Alt + Ctrl + F Tekee viimeksi tehdyn efektin uudelleen ja avaa ko. efektin 
parametriruudun 

Ctrl + G Ryhmittää edellisen kanssa 

Ctrl + H -- 

Ctrl + I Negatiivivärit 

Ctrl + J Kopioi valitun tason 

Ctrl + K Avaa asetukset ikkunan 

Ctrl + L Levels 

Ctrl + M Curves 

Ctrl + N Uusi työ 

Ctrl + O Avaa tiedoston 

Ctrl + P Tulostaa 

Ctrl + Q Lopettaa ohjelman 

Ctrl + R Viivottimet päälle/pois 

Ctrl + S Tallentaa työn 

Shift + Ctrl + S Tallentaa nimellä 

Shift + Ctrl + Alt + S Tallentaa gif/jpg/png formaattiin 

Ctrl + T Free transform 

Ctrl + U Hue/Saturation/Colorize 

Ctrl + V Liittää 

Ctrl + W Sulkee tiedoston 

Ctrl + X Leikkaa 

Ctrl + Y Vaihtaa väriasetuksia 

Ctrl + Z Kumoaa viimeksi tehdyn muutoksen 

 


